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Preface
■ Introduction
This guide describes the product information, mechanical installation, electrical
installation, programming, commissioning, and troubleshooting of the product.

■ Standard
The following table lists the certifications, directives, and standards that the product
may comply with. For details about the acquired certificates, see the certification
marks on the product nameplate.

Certifica-
tion

Directive Standard

CE
Certifica-
tion

EMC Directive 2014/30/EU 24 VDC products:
EN 61131-2
220 VAC products:
EN 61131-2
EN 61000-3-2
EN 61000-3-3

LVD Directive 2014/35/EU EN 61010-1
EN 61010-2-201

RoHS Directive 2011/65/EU
amended by (EU)
2015/863

EN IEC 63000

UL/cUL
Certifica-
tion

- UL 61010-1
UL 61010-2-201
CAN/CSA-C22.2 No. 61010-1
CSA C22.2 NO. 61010-2-201

KCC
Certifica-
tion

- -

EAC
Certifica-
tion

- -
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Certifica-
tion

Directive Standard

UKCA
Certifica-
tion

Safety
Regulations

Electrical
Equipment (Safety)
Regulations 2016

EN 61010-1
EN 61010-2-201

EMC
Regulations

Electromagnetic
Compatibility
Regulations 2016

24 VDC products:
EN 61131-2
220 VAC products:
EN 61131-2
EN 61000-3-2
EN 61000-3-3

RoHS
Regulations

Directive (RoHS)
Regulations 2012

EN IEC 63000

■ Revision History

Revision date Version Description

February
2025

A04 ● Modified the "Software specifications" in "1.4 Technical
Specifications" on page 16.

● Modified the "Fifth release: 2.4.1.0 firmware (MCU)" in "1.6
Release Notes" on page 21.

● Modified the "Notes on GSD File Updates" in "4.5 Notes"
on page 66.

● Modified the "Import the GSD file" part in "4.2 Applicable
for TIA Portal" on page 40.

● Modified the step 1 of the "Operation Example" in "6.2
Share IN and Share OUT Mapping Modules" on page 76.

August 2024 A03 Made minor corrections.

June 2024 A02 Added the following content:
Added "2.1 Installation Precautions" on page 27.

Updated the following content:

● Modified the "Input PDO data volume" and "Output PDO
data volume" in "1.4 Technical Specifications" on page 16.

● Modified the "Fourth release: 2.4.0.0 firmware (MCU)" in
"1.6 Release Notes" on page 21.
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Revision date Version Description

September
2023

A01 Added the following content:

● Added "1.1 Product Introduction" on page 10.
● Added "1.6 Release Notes" on page 21.
● Added " Program Commissioning" on page 35.
● Added "6.1 Configuring the MRP" on page 73.
● Added "6.3 Expansion Module Parameter Description" on
page 81.

● Added "6.4 DeviceStates Command" on page 89.
● Added "6.5 Firmware 2.0.0.5 and GSD 20230323
Compatibility" on page 95.

Modified the following content:

● Added "General Specifications" and updated expansion
capabilities in "1.4 Technical Specifications" on page 16.

● Optimized the content in "6.2 Share IN and Share OUT
Mapping Modules" on page 76.

Deleted the following content:
Deleted the "Supported Module" and "Analog Channel &
Matching Values" sections.

September
2022

A00 Initial release.

■ Access to the Guide
This guide is not delivered with the product. You can obtain the PDF version by the
following methods:

● Do keyword search under Service and Support at www.inovance.com.
● Scan the QR code on the product with your smart phone.

● Scan the QR code below to install My Inovance app, where you can search for and
download user guides.

www.inovance.com
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■ Warranty Disclaimer
Inovance provides warranty service within the warranty period (as specified in your
order) for any fault or damage that is not caused by improper operation of the user.
Maintenance will be charged after the warranty expires.

Within the warranty period, maintenance will be charged for the following damage:
● Damage caused by operations not following the instructions in the user guide

● Damage caused by fire, flood, or unusual voltage

● Damage caused by unintended use of the product

● Damage caused by use beyond the specified scope of application of the product
● Damage or secondary damage caused by force majeure (natural disaster,

earthquake, and lightning strike)

The maintenance is charged according to the latest Price List of Inovance. If otherwise
agreed upon, the terms and conditions in the agreement shall prevail.

For details, see the Product Warranty Card.
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Safety Precautions
■ Safety Disclaimer
1. Read through the safety instructions before installing, operating, and servicing the

equipment, and comply with these instructions.
2. To ensure personal and equipment safety, observe the notes indicated on the

product labels and all the safety instructions in the user guide.
3. “CAUTION”, “WARNING”, and “DANGER” in this guide only indicate some of the

precautions that need to be followed; they just supplement the safety precautions.
4. Use this product in environments meeting the design and specification

requirements; otherwise, a fault may occur. Noncompliance-caused malfunction or
damage to parts are not covered in product quality warranty.

5. Inovance shall take no responsibility for any personal injury or property damage
caused by improper use.

■ Safety Levels and Definitions

 "DANGER" indicates that failure to comply with the notice will result in death
or severe personal injuries.

 "WARNING" indicates that failure to comply with the notice may result in
death or severe personal injuries.

 
"CAUTION" indicates that failure to comply with the notice may result in
minor or moderate personal injury or equipment damage. Keep this user
guide properly for future use and deliver it to the end user.
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Control System Design

 

● Provide a safety circuit outside the PLC so that the control system can still work safely
once external power failure or controller fault occurs.

● Add a fuse or circuit breaker because the module may smoke or catch fire due to long-
time overcurrent caused by operation above rated current or load short-circuit.

 

● An emergency stop circuit, a protection circuit, a forward/reverse operation interlocked
circuit, and an upper position limit and lower position limit interlocked circuit must be
set in the external circuits of PLC to prevent damage to the machine.

● To ensure safe operation, for the output signals that may cause critical accidents, use
external protection circuits and safety mechanism.

● Once PLC CPU detects abnormality in the system , all outputs may be closed; however,
when a fault occurs in the controller circuit, the output may not be under control.
Therefore, it is necessary to design an appropriate external control circuit to ensure
normal operation.

● If the PLC output units such as relays or transistors are damaged, the output may fail to
switch between ON and OFF states according to the commands.

● The PLC is designed to be used in an indoor electrical environment (overvoltage category
II). The power supply must have a system-level surge protector, assuring that overvoltage
due to lightning shock can't be applied to the PLC's power supply input terminals, signal
input terminals and output terminals, to prevent damage to the equipment.



‑7‑

Installation

 

● Installation must be carried out by skilled personnel who have undergone specialized
electrical training and possess comprehensive electrical expertise.

● Disconnect all external power supplies of the system before removing/installing the
module. Failure to do so may result in electric shock, module fault or malfunction.

● Do not use the PLC in environments with dust, greasy smoke, conductive dust, corrosive
or combustible gases, exposed to high temperature, condensation, wind & rain, or
subject to vibration and shock. Electric shock, fire and malfunction may also result in
damage or deterioration to the product.

● The PLC is open-type equipment that must be installed in a control cabinet with lock
(cabinet housing protection > IP20). Only the skilled personnel who have undergone
specialized electrical training and possess comprehensive electrical expertise can open
the cabinet.

 

● Prevent metal filings and wire ends from dropping into ventilation holes of the PLC
during installation. Failure to comply may result in fire, fault and malfunction.

● Ensure there are no foreign matters on ventilation surface. Failure to comply may result
in poor ventilation, which may cause fire, fault and malfunction.

● Ensure the module is connected to the respective connector securely and hook the
module firmly. Improper installation may result in malfunction, fault or fall-off.

● Ensure natural ventilation for the equipment.

Wiring

 

● Wiring must be carried out by skilled personnel who have undergone specialized
electrical training and possess comprehensive electrical expertise.

● Disconnect all external power supplies of the system before wiring. Failure to comply
may result in electric shock, module fault or malfunction.

● Install the terminal cover attached to the product before power-on or operation after
wiring is done. Failure to comply may result in electric shock.

● Insulate the cable terminals properly to ensure the insulation distance between cables
will not be shortened after cables are connected to the terminal block. Failure to comply
may result in electric shock or damage to the equipment.
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Wiring

 

● To avoid electric shock, cut off the power supply before connecting the equipment to the
power supply.

● The input power supply of this product must be 24 VDC. Power supplies outside ±20％ of
24 VDC can cause severe damage to the product. Therefore, check whether the DC power
supply provided by the switching-mode power supply is stable at a regular interval.

Operation and Maintenance

 

● Operation and maintenance must be carried out by skilled personnel who have
undergone specialized electrical training and possess comprehensive electrical expertise.

● Do not touch the terminals while the power is on. Failure to comply may result in electric
shock or malfunction.

● Disconnect all external power supplies of the system before cleaning the module or re-
tightening screws on the terminal block or screws of the connector. Failure to comply
may result in electric shock.

● Disconnect all external power supplies of the system before assembling/disassembling
the module or connecting/removing the communication cables. Failure to comply may
result in electric shock or malfunction.

Safety Recommendations

● In the position where the operator directly touches the machinery part, for example,
where a machinery tool is loaded/unloaded, or where a machine runs automatically, the
on-site manual operating devices and any other alternative means must be carefully
arranged and designed so that they are independent of the programmable controller and
can start or terminate the automatic running of the system.

● If modification on the program is needed during system operation, use the lock function
or other protective measures. Ensure that only authorized personnel can make the
necessary modifications.
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Disposal

 

● Treat the scrapped product as industrial waste. Dispose of the battery according to local
laws and regulations.

● Recycle retired equipment by observing industry waste disposal standards to avoid
environmental pollution.
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1 Product Information

1.1 Product Introduction

■ Overview
GL20-RTU-PN communication interface module connects to the PROFINET network as
a PROFINET slave. With this module, you can expand the system with Inovance local
modules such as GL20 series digital modules, analog modules, and temperature
detection modules ( "1.6 Release Notes" on page 21). It can be used together with the
PROFINET master devices, such as S7-200 Smart, S7-300, S7-400, S7-1200, and S7-
1500 series. The topology is shown in the figure below.

■ Bus current consumption
Modules with firmware version 2.2.0.0 or later support up to 32 GL20 series local
expansion modules. Modules with firmware versions earlier than 2.2.0.0 support up to
16 expansion modules. If the GL20-PS2 relay power module (hereinafter referred to as
expansion modules) is present, the maximum number of supported expansion
modules must include the count of GL20-PS2 modules. The actual number of
supported expansion modules needs to be calculated based on the total bus current
consumption.

When the number of expansion modules exceeds 16 or when the total bus current
consumption of the expansion modules ( "1.6 Release Notes" on page 21) exceeds the
bus supply current of this module, that is, 2 A, it is necessary to add a GL20-PS2
module to supply power to the expansion modules.
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The formula for calculating the total bus current consumed by the expansion
modules is as follows:

Total bus current consumption of expansion modules = Bus consumption current of
expansion module #1 + Bus consumption current of expansion module #2 + ... + Bus
consumption current of expansion module #n
● When a GL20-PS2 module is not provided, the total bus current consumption of

the expansion modules cannot exceed 2 A, and the number of expansion modules
cannot exceed 16.
For example, this module can support up to 8 GL20-3232ETN-M modules each with
a bus current consumption of 250 mA (2 A/250 mA = 8), or up to 16 GL20-0008ETP
modules each with a bus current consumption of 80 mA (16 x 80 mA = 1280 mA ≤
2 A).

● When a GL20-PS2 module is provided, it supplies power to the surplus expansion
modules. The number of expansion modules supported by the GL20-PS2 module
is determined by the total bus current consumption of the expansion modules,
similar to the above calculation method of this module. Note that if one GL20-PS2
module is provided, then its bus current consumption must be included in the
total supply current of this module. If multiple GL20-PS2 modules are provided,
the bus current consumption of a certain GL20-PS2 module must be included in
the total supply current of the immediately previous GL20-PS2 module.
For example, given that 8 GL20-3232ETN-M modules or 16 GL20-0008ETP modules
are already added to this module. If you want to add more expansion modules, a
GL20-PS2 module is required for additional power supply. In this case, remove at
least one GL20-3232ETN-M module or at least one GL20-0008ETP module to
reserve the bus supply current margin of this module to supply power to the GL20-
PS2 module. The GL20-PS2 module consumes a bus current consumption of 55
mA and provides a bus current of 2 A.
For example, a GL20-RTU-ECT32 module equipped with a GL20-PS2 module can
support up to 15 GL20-3232ETN-M modules (7 by this module and 8 by the GL20-
PS2 module, with a total current consumption of 15 x 250 mA = 3750 mA) or 31
GL20-0008ETP modules (15 by this module and 16 by the GL20-PS2 module, with a
total current consumption of 31 x 80 mA = 2480 mA).

The following figure shows the power supply diagram of this module.
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● The GL20-PS2 module and the GL20-RTU-ECT module must be powered on
simultaneously (the GL20-PS2 module is allowed to be powered on at most
two seconds later than the GL20-RTU-ECT module), otherwise addressing
may fail.

● Do not place the GL20-PS2 module in the last slot of the configuration.

1.2 Naming Rules and Nameplate

① Product information
GL: Inovance general local module

③ I/O type
RTU: Remote interface module

② Series number
20: 20 series module

④ Communication protocol
PN: PROFINET
ECT: EtherCAT
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The data for ordering the product is shown below.
Model Description Material

Code
Applicable Model

GL20‑RTU‑PN GL20 series PROFINET
communication interface
module

01440289 Siemens PROFINIT
master devices such as
S7-1200 and S7-1500.
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1.3 Components
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No.
Interface
Name

Description

① Signal
indicator

PWR Power
indicator

Solid on (green) ON when power supply is
switched on.

RUN RUN
indicator

OFF The module is initializing.

Flashing (green) The module is in parameter
configuration mode or
waiting to connect to the
master device.

Single flash
(green)

The module is in safe
operational mode (can read
inputs, cannot update
outputs).

Solid on (green) The module communication
is normal.

ERR
Communica-
tion fault
indicator

OFF No communication error

Solid on (red) No expansion module
presents. For details, see "
Fault Diagnosis" on page 70

Flashing (red) The configuration for
expansion modules is
inconsistent. For details, see
" Fault Diagnosis" on page 70

Single flash (red) The module is offline or the
expansion module
synchronization error occurs.

SF Module fault
indicator

OFF The expansion module is
normal.

Solid ON Local bus error occurs. For
details, see " Fault Diagnosis"
on page 70

Flashing (red) The expansion module is
faulty. For details, see " Fault
Diagnosis" on page 70

② PROFINET
interface

P1: PROFINET interface 1

P2: PROFINET interface 2
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No.
Interface
Name

Description

③ Power
supply
terminal

+24 V Power supply +

0 V Power supply -

Function grounding

Note
● Flashing: Flashes at an interval of 200 ms.
● Single flash: Flashes at an interval of 1s.
● Double flash: Flashes twice at an interval of 1s.

1.4 Technical Specifications

■ General specifications

Item Specification

IP rating IP20

Dimensions (W x H x D) 24 mm x 100 mm x 100.5 mm

Weight (g) Approx. 100 g

■ Power supply specifications

Item Specification

Rated voltage of
terminal input power
supply

24 VDC (20.4 VDC to 28.8 VDC)

Rated current of
terminal input power
supply

0.6 A (typical@24 V)

Rated voltage of bus
output power supply

5 VDC (4.75 VDC to 5.25 VDC)
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Item Specification

Rated current of bus
output power supply

2 A (typical@5 V)

Power supply protection Anti-reverse connection protection, and surge absorption
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■ Software specifications

Item Specification

Basic
specifi-
cations

Input PDO
data volume

Max. 1,440 bytes

Output PDO
data volume

Max. 1,440 bytes

Communica-
tion mode

RT mode

Minimum
communica-
tion cycle

1 ms

I&M data I&M0 to I&M3

PROFINET
version

V2.3

Expansion
capability

● Versions earlier than 2.2.0.0: Support up to 16 expansion
modules

● Version 2.2.0.0 and later: Support up to 32 expansion modules

Number of
PROFINET
interfaces

2

PROFINET
switch
capability

Networking

Open IE Support standard Ethernet protocols, such as TCP/IP, SNMP,
and LLDP

Alarm/
diagnosis/
status
information

Supported, allowing uploading of error code from local to PLC
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Item Specification

I/O
Service

Physical layer 100BASE-TX

Communica-
tion rate

10 Mbps (standard Ethernet), 100 Mbps (PROFINET)

Communica-
tion mode

Full duplex

Topology Linear, star, tree

Transmission
medium

Cat5e and above

Transmission
distance

Less than 100 m between two nodes

Priority boost Supported

MRP Supported. For details, see "6.1 Configuring the MRP" on page
73.

Port disable Supported

Zero
configuration
for module
replacement

Supported (For replacement of PN module of the same type)

Factory reset
of GL20-RTU-
PN

Supported

Factory reset
of module

Not supported

Firmware
update of
GL20-RTU-PN

Supported
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Note
Each GL20-RTU-PN communication interface module can be configured with a
maximum of 120 modules (the sum of actual expansion modules and sub-modules).
Exceeding this limit will cause the GL20-RTU-PN communication interface module to
go offline and cease operation. For example, if the configuration includes one GL20-
2SCOM-MDB expansion module and one GL20-1600END expansion module, where the
GL20-2SCOM-MDB expansion module contains multiple "Master Read Holding
Register Modules (referred to as sub-modules)", the total current module count is the
sum of GL20-2SCOM-MDB expansion module, GL20-1600END expansion module, and
sub-modules. Given that the total number of expansion modules is 2, the number of
sub-modules cannot exceed 118.

1.5 Environmental Specifications
Item Specification

Installation/
application
environment

Free from conductive dust, conductive fibers, explosive dust,
flammable gases, water mist/greasy dirt, corrosive dusts/gases,
strong vibration, and repetitive shock

Altitude ≤ 2,000 m

Pollution degree 2

Immunity 2 kV on power supply cable (compliant with IEC 61000-4-4)

Overvoltage category I

EMC immunity level Zone B, IEC61131-2

Anti-static rating Contact discharge +/-6 kV and air discharge +/-8 kV

Vibration resistance ● Application scenario: Tested according to IEC60068-2-6, 3.5 mm
amplitude from 5 Hz to 8.4 Hz; 1 g acceleration from 8.4 Hz to 200
Hz; 10 cycles per axial direction

● Transportation scenario: Tested according to IEC60068-2-64, 0.01
g2/Hz power spectral density from 5 Hz to 100 Hz; 0.001 g2/Hz
power spectral density at 200 Hz; 1.14 g Grms
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Item Specification

Shock resistance Application/Transportation scenario: Tested according to
IEC60068-2-27; 15 g peak acceleration, 11 ms pulse width, 18
cycles in total in X, Y and Z axial directions

Operating
temperature/humidity

● Temperature: -20°C to +55°C
● Humidity: < 95% RH (30℃), without condensation

Storage temperature/
humidity

● Temperature: -20°C to +60°C
● Humidity: < 95% RH (30℃), without condensation

Transportation
temperature/humidity

● Temperature: -40°C to +70°C
● Humidity: < 95% RH (40℃), without condensation

1.6 Release Notes

This section describes the expansion modules, functions, and GSD file versions com-
patible with the released firmware versions.

■ Fifth release: 2.4.1.0 firmware (MCU)
● New compatible expansion modules
Product

No.
Product Model Product Description Firmware

Version
Bus Current
Consump-

tion

01440623 GL20-8DAV GL20 series 8-channel
analog output module -
voltage type

Logic software:
0.2.2.0 and
later
Board
software:
1.0.3.0 and
later

100 mA

01440622 GL20-8DAI GL20 series 8-channel
analog output module -
current type

Logic software:
0.2.2.0 and
later
Board
software:
1.0.3.0 and
later

100 mA
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Product
No.

Product Model Product Description Firmware
Version

Bus Current
Consump-

tion

01440835 GL20-2S485-MDB GL20 series 2-channel
RS485 module (Modbus)

Logic software:
0.2.2.0 and
later
Board
software:
1.0.2.0 and
later

155 mA

01440823 GL20-1600END-5V GL20 series 16-channel
digital input module

Logic software:
0.2.1.1 and
later

120 mA

● New and optimized functions
■ Compatible with GL20-8DAV, 8DAI, and GL20-1600END-5V modules.
■ Resolved the issue of the GL20-RTU-PN module going offline due to external

TCP connections.

● Compatible GSD file version: 20240401

■ Fourth release: 2.4.0.0 firmware (MCU)
● New compatible expansion modules
Product

No.
Product model Product description Firmware

Version
Bus Current
Consump-

tion

01440519 GL20-2HC GL20 series 2-channel
high-speed counting
module

Logic software:
0.1.7.0 and
later
Board
software:
1.2.3.0 and
later

95 mA

01440506 GL20-0404ETP-5V GL20 series 4-channel
digital input and 4-channel
digital output 5V module

Logic software:
0.1.12.0 and
later

90 mA
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Product
No.

Product model Product description Firmware
Version

Bus Current
Consump-

tion

01440512 GL20-0004ETP-2A GL20 series 4-channel
large current digital PNP
output module

Logic software:
0.1.14.0 and
later

80 mA

01440673 GL20-2SCOM-MDB GL20 series serial port
communication module

Logic software:
0.2.2.0 and
later
Board
software:
1.0.2.2 and
later

170 mA

● New and optimized functions
■ Compatible with the GL20-2SCOM-MDB serial communication module,

supporting both Modbus protocol and free protocol.
■ Supports power overload fault alarm for the GL20-PS2 relay power module.
■ Optimized the fault diagnosis function.

● Compatible GSD file version: 20240401

■ Third release: 2.2.0.0 firmware (MCU)
● New compatible expansion modules
Product

No.
Product model Product description Firmware

Version
Bus Current
Consump-

tion

01440351 GL20-PS2 GL20 series programmable
logic controller power
supply module

Logic software:
0.1.A.0 and
later

55 mA

01440445 GL20-2SSI GL20 series programmable
logic controller SSI
communication module

Board
software:
1.1.6.0 and
later

115 mA

01440467 GL20-0032ETN GL20 series 32-channel
NPN transistor output
module

Logic software:
0.1.2.0 and
later

80 mA
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Product
No.

Product model Product description Firmware
Version

Bus Current
Consump-

tion

01440466 GL20-3200END GL20 series 32-channel
digital input module

Logic software:
0.1.2.0 and
later

85 mA

01440489 GL20-8ADI GL20 series 8-channel
analog input module -
current type

Board
software:
1.1.0.3 and
later

65 mA

01440482 GL20-8ADV GL20 series 8-channel
analog input module -
voltage type

Board
software:
1.1.0.3 and
later

65 mA

01440479 GL20-4AD-DF GL20 series 4-channel
analog input module
(differential input)

Board
software:
1.1.5.0 and
later

95 mA

01440485 GL20-0004ER GL20 series 4-channel relay
output general-purpose
module

Logic software:
0.1.4.0 and
later

90 mA

● New functions
Supports TIA Portal online scanning and automatic configuration for GL20-RTU-PN
module and expansion modules.

● Compatible GSD file version: 20230523

■ Second release: 2.1.1.0 firmware (MCU)
● New compatible expansion modules
Product

No.
Product model Product description Firmware

Version
Bus Current
Consump-

tion

01440334 GL20-0008ER GL20 series 8-channel relay
output general-purpose
module

Logic software:
0.1.2.0 and
later

110 mA

01440381 GL20-0800END GL20 series 8-channel
digital input module

Logic software:
0.1.2.0 and
later

105 mA
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Product
No.

Product model Product description Firmware
Version

Bus Current
Consump-

tion

01440379 GL20-0008ETN GL20 series 8-channel
digital NPN transistor
output module

Logic software:
0.1.2.0 and
later

115 mA

01440380 GL20-0008ETP GL20 series 8-channel
digital PNP transistor
output module

Logic software:
0.1.2.0 and
later

80 mA

01440339 GL20-0808ETN GL20 series module with 8-
channel digital inputs and
8-channel NPN transistor
outputs

Logic software:
0.1.2.0 and
later

130 mA

01440290 GL20-3232ETN-M GL20 series module with
32-channel digital inputs
and 32-channel NPN
transistor outputs
(external terminal block)

Logic software:
0.1.2.0 and
later

250 mA

01440377 GL20-0032ETN-M GL20 series module with
32-channel NPN transistor
outputs (external terminal
block)

Logic software:
0.1.2.0 and
later

85 mA

01440378 GL20-3200END-M GL20 series 32-channel
digital input module
(external terminal block)

Logic software:
0.1.2.0 and
later

95 mA

01440337 GL20-4PT GL20 series 4-channel
input thermal resistor
temperature detection
module

Board
software:
2.0.5.0 and
later

95 mA

01440338 GL20-4TC GL20 series 4-channel
thermocouple temperature
detection module

Board
software:
2.0.5.0 and
later

95 mA

● New functions
■ Supports the range of -27,648 to +27,648 for GL20-4AD and GL20-4DA modules.
■ Supports overflow detection enable function for GL20-4AD, GL20-4TC, and

GL20-4PT modules.
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■ Supports MRP function. For details, see "6.1 Configuring the MRP" on page 73
● Compatible GSD file version: 20230323

■ First release: 2.0.0.5 firmware (MCU)
● Compatible expansion modules
Product

No.
Product model Product description Firmware

Version
Bus Current
Consump-

tion

01440291 GL20-1600END GL20 series 16-channel
digital input module

Logic software:
0.1.2.0 and
later

120 mA

01440292 GL20-0016ETP GL20 series 16-channel
digital PNP transistor
output module

Logic software:
0.1.2.0 and
later

100 mA

01440293 GL20-0016ETN GL20 series 16-channel
digital NPN transistor
output module

Logic software:
0.1.2.0 and
later

145 mA

01440288 GL20-4AD GL20 series 4-channel
analog input module

Board
software:
1.1.5.0 and
later

95 mA

01440287 GL20-4DA GL20 series 4-channel
analog output module

Board
software:
1.1.5.0 and
later

70 mA

● Compatible GSD file version: 20220930
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2 Mechanical Installation

2.1 Installation Precautions
● Make sure the module is powered off before installing or removing.
● Do not hot swap the modules. Otherwise, the modules may be damaged by

overcurrent or overvoltage, and the communication interface module or PLC may
be subject to restart, user data loss or corruption.

● Do not drop or shock the housing or terminals of the module to avoid damage.

2.2 Installation Dimensions

■ Module
The installation dimensions (in mm) are shown in the figure below.
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■ Cable connection

■ End Cover

2.3 Installation Method

■ Installing the modules to each other
The module is mounted onto a DIN rail according to IEC 60715 (width: 35 mm,
thickness: 1 mm). The dimensions (unit: mm) are shown below.
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If the module is not installed on the recommended DIN rail (especially when the DIN
rail thickness is not 1.0 mm), DIN rail buckles may not be locked. In this case, the
module cannot be installed in place and will fail to work properly.

1. Remove the end cover in the direction indicated by the arrow, as shown below.

2. Install the modules to each other through top and bottom guide rails, as shown
below.
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■ Installing the module onto DIN rail
1. Align the module with the DIN rail and push the module in the direction indicated

by the arrow until you hear a click, as shown below.

2. Make sure the DIN rail mounting hook of the module is locked. The locked and
unlocked states of the mounting hook are shown below.

● If the mounting hook is pressed down, it is locked.

● If the mounting hook is lifted up, it is unlocked.
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To lock the module to the DIN rail, press down the mounting hook.

When the module is not installed on the DIN rail, keep the rail buckles in locked state.
If the rail buckles remain in unlocked state for a long period of time, they will be
invalidated.

3. Install the end cover on the last module to prevent the metal pin from being
exposed. Install an end plate on each side of the main unit or the module to
prevent the module from sliding, as shown below.
To install the end plate, hook the bottom of it to the bottom of the DIN rail, rotate
the end plate to hook the top of it to the top of the DIN rail, and then tighten the
screw to lock the end plate in place.

■ Removal
Pry the DIN rail mounting hook upwards with a tool such as a slotted screwdriver, and
pull the module away from the DIN rail to remove it. Then, press down the top of the
mounting hook, as shown below.
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3 Electrical Installation

3.1 Cable Selection

■ Communication cable
PROFINET bus communication utilizes shielded cables for network data transmission,
ensuring no short circuits, misalignments, or poor contact issues. The cable length
between devices must not exceed 100 m, as exceeding this limit may cause signal
attenuation and disrupt normal communication. It is recommended to use cables
specified as follows.

Item Specification

Cable type Flexible crossover cable, S-FTP, Cat 5e

Standard EIA/TIA568A, EN50173, ISO/IEC11801
EIA/TI Abulletin TSB, EIA/TIA SB40-A&TSB36

Cross sectional area AWG26

Conductor type Twisted pair

Number of pairs 4

■ Power supply cable
The cable lug and cable diameter included in the following table are only for
reference.

Material
Name

Applicable Cable
Diameter

Applicable Cable
Diameter

Suzhou Yuanli

mm2 AWG Model Crimping
Tool

Model
Crimping

Tool

Tubular lug

0.5 20 E0508

KST2000L

0508

YAC-5
0.75 18 E7508 7508

1.0 18 E1008 1008

1.5 16 E1508 1508

The shape and dimension requirements of the crimped terminals are as shown in the
figure below.
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■ External interface specifications

Type Interface
Name

Cable Type/
Max Length

Description User
Terminal

Performance
Metrics

PROFINET
interface

PROFINET Shielded
network
cable, 100 m

PROFINET
communica-
tion interface

RJ45 x 2 100 Mbps
(100Base-TX)

Power supply 24 V input 3-core
unshielded
cable, 20 m

24 V power
supply input

6-pin
pluggable
terminal
block

24 V/1 A

3.2 Terminal Wiring
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4 Programming Commissioning

4.1 Applicable for STEP7 MicroWIN
Prerequisite
● The relationship between the firmware version compatibility of the GL20-RTU-PN

module, the expansion modules, their firmware versions, functionalities, and GSD
file versions has been understood. For details, see "1.6 Release Notes" on page 21.

Note
To check the firmware version and related module versions of the GL20-RTU-PN
module, See "6.2 Share IN and Share OUT Mapping Modules" on page 76.

● The GSD file is ready. You can get the GSD file from https://www.inovance.com.

Operating procedure

1. Complete the cable connections, then power on and initiate the operation of this
product.

2. Import the GSD file.

a. In the STEP7 main interface, select File > GSDML Management to open the
"Manage general station description file" dialog box, as shown in the figure
below.

https://www.inovance.com/portal/product/details?productId=343.
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b. Click Browse to select the path where the GSD file is located, then click OK.

3. Configure the PLC IP address.

a. Expand Wizards in the left project tree, double-click PROFINET, and check the
PLC Role as Controller, as shown in the figure below.

b. Configure the IP Address according to the actual PLC IP address, as shown in
the figure below.
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4. Configure the GL20-RTU-PN module.

a. Double-click the Controller to enter the configuration interface.
b. In the configuration interface, expand the directory tree on the right to

PROFINET-IO > I/O > INOVANCE > INOVANCE > GL20, select GL20, and click
Add.

5. Modify the device name and IP address of the GL20-RTU-PN module.



‑38‑

a. In the STEP7 main interface, select Tools > Find PROFINET Devices to display
the device name, as shown in the figure below.

b. In the "Device Name" and "IP Address" lists, modify the device name and IP
address of the GL20-RTU-PN module to match the actual device name and IP
address, as shown in the figure below.
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6. Configure the expansion module.

a. Double-click the configured GL20-RTU-PN module in the left project tree to
access the expansion module configuration interface, as shown in the figure
below.

b. Click the expansion modules in the right directory tree according to the actual
installation sequence, then click Add to add the expansion modules and
automatically assign input/output addresses (I area and Q area).

7. After configuration, click Generate to complete the configuration wizard setup.
Programming Examples



‑40‑

Taking the first GL20-0016ETN module in the figure above as an example, the address
ranges are configured as follows:

● First 8 points: Q128.0 to Q128.7

● Post 8 points: Q129.0 to Q129.7

Program directly using the default assigned addresses, as shown in the figure below.

4.2 Applicable for TIA Portal
Prerequisite

● The relationship between the firmware version compatibility of the GL20-RTU-PN
module, the expansion modules, their firmware versions, functionalities, and GSD
file versions has been understood. For details, see "1.6 Release Notes" on page 21.

Note
To check the firmware version and related module versions of the GL20-RTU-PN
module, See "6.2 Share IN and Share OUT Mapping Modules" on page 76.

● The GSD file is ready. You can get the GSD file from https://www.inovance.com.

Operating procedure

1. Complete the cable connections, then power on and initiate the operation of this
product.

2. Import the GSD file.

a. In the TIA Portal menu bar, select Options > Manage general station
description files (GSD), as shown in the figure below.

https://www.inovance.com/portal/product/details?productId=343.
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b. In the opened dialog box, click ①, select the source path where the GSD file
is located (the software will automatically index the file) ②, check the GSD file
③, and click Install ④ to install the GSD file, as shown in the figure below.
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c. The progress of installing the GSD file will display, and a "Manage general station
description files" dialog will pop up upon completion, showing "Installation
completed successfully" as the "Installation Result" message, as shown in the
figure below.
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d. A GSD installation update information will display, and then the GSD installation
interface will automatically exit when the update is completed.
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3. On the main interface, select Project tree > Devices > Online access, then double-
click Update accessible devices under the corresponding network card of the PLC
to scan for online GL20-RTU-PN module, as shown in the figure below.
The scan result will be displayed below, such as "gl20" shown in the figure below.

4. Assign an IP address and PROFINET device name for the GL20-RTU-PN module.

a. Double-click Online & diagnostics under the scanned GL20-RTU-PN module. In
the right-hand interface, select Functions > Assign IP address, configure the IP



‑45‑

address and subnet mask for the GL20-RTU-PN module, then click Assign IP
address, as shown in the figure below.

The IP address of the GL20-RTU-PN module must be in the same subnet as the PLC.

b. Select Functions > Assign PROFINET device name, configure the PROFINET
device name and click Assign name to complete the configuration, as shown in
the figure below.

c. Check the configuration result.
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Upon successful configuration, the PROFINET device name and IP address will
be displayed under the corresponding network card of the PLC in the left project
tree, as shown in the figure below.

5. Configure the GL20-RTU-PN and expansion modules. Automatic and manual
configuration methods are supported.

● Automatic configuration

a. In the menu bar, select Online > Hardware detection > PROFINET devices from

network, as shown in the figure below.

b. Select the corresponding network card, click Start search, check the GL20-RTU-PN

communication interface module to be configured, and click Add devices.
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After the GL20-RTU-PN communication interface module is successfully
added, a pop-up message displays indicating the hardware detection of the
device has been successfully completed.

Note
If the addition fails, disconnect the network cable connection between the PLC and
the GL20-RTU-PN module, then reconnect it, and repeat steps a to b.

c. Hold down the left mouse button and drag the green frame of the PLC to the green

frame of the GL20-RTU-PN module to connect the PLC and the GL20-RTU-PN

module, as shown in the figure below.
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d. Double-click the GL20-RTU-PN module in the network view to open the device

view, as shown in the figure below.

e. (Optional) Assign I address or Q address for the module.

Note
If this product interfaces with the S7-300 series master and the CP343-1 Ethernet
communication module, and only Inovance expansion modules are used, it is
recommended to modify the I or Q address of the first module to start from "0" to
facilitate parameter configuration when using the PNIO_SEND(FC11) and PNIO_RECV
(FC12) program blocks later. Otherwise, attention must be paid to the relevant
parameter configurations. For details, see "4.5 Notes" on page 66.

f. Click on the expansion module to be configured in the network view, then configure

the corresponding module parameters under Properties > General > Module

parameters. For detailed descriptions of the module parameters, see "6.3
Expansion Module Parameter Description" on page 81.

● Manual configuration
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a. Double-click GL20 or drag GL20 to the network view in the hardware catalog, as

shown in the figure below.

b. Hold down the left mouse button and drag the green frame of the PLC to the green

frame of the GL20-RTU-PN module to connect the PLC and the GL20-RTU-PN

module, as shown in the figure below.

c. Double-click the GL20-RTU-PN module in the network view to open the hardware

catalog, as shown in the figure below.
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d. According to the actual module installation sequence, double-click the expansion

modules in the hardware catalog on the right side to add them and automatically

assign addresses.

Note
If this product interfaces with the S7-300 series master and the CP343-1 Ethernet
communication module, and only Inovance expansion modules are used, it is
recommended to modify the I or Q address of the first module to start from "0" to
facilitate parameter configuration when using the PNIO_SEND(FC11) and PNIO_RECV
(FC12) program blocks later. Otherwise, attention must be paid to the relevant
parameter configurations. For details, see "4.5 Notes" on page 66.

e. Click on the expansion module to be configured in the network view, then

configure the corresponding module parameters under Properties > General >

Module parameters. For detailed descriptions of the module parameters, see "6.3
Expansion Module Parameter Description" on page 81.

6. Download the program to the device and switch to online.

a. Click in the toolbar to open the "Load preview" dialog box, as shown in the
figure below.
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b. Click Load to download the program to the device.

c. Click in the toolbar to open the dialog box, as shown in the figure
below.

d. Check the PLC and click GoOnline.

7. Check that the GL20-RTU-PN module is successfully configured.
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If green icons are displayed in both the project tree and network view, it indicates
that the GL20-RTU-PN module is successfully configured; otherwise, the
configuration is unsuccessful, as shown in the figure below.

If the configuration is unsuccessful, contact Inovance for technical support.

4.3 Applicable for STEP7
Prerequisite

● The relationship between the firmware version compatibility of the GL20-RTU-PN
module, the expansion modules, their firmware versions, functionalities, and GSD
file versions has been understood. For details, see "1.6 Release Notes" on page 21.

Note
To check the firmware version and related module versions of the GL20-RTU-PN
module, See "6.2 Share IN and Share OUT Mapping Modules" on page 76.

● The GSD file is ready. You can get the GSD file from https://www.inovance.com.

Operating procedure

1. Complete the cable connections, then power on and initiate the operation of this
product.

https://www.inovance.com/portal/product/details?productId=343.
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2. Create a new project, taking the S7-300 CPU315-2 PN/DP as an example, as shown
in the figure below.

3. Import the GSD file.

a. Double-click the Hardware in the STEP7 main interface, then select Options >
Install GSD Files from the menu bar to open the "Install GSD Files" dialog box,
as shown in the figure below.

b. Click Browse... to select the path where the GSD file is located, then click OK.
c. Click Install to start the installation. Once the installation is complete, the GL20

series module can be found in the device list on the right, as shown in the figure
below.
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4. Configure the GL20-RTU-PN module.

a. Right-click on PN-IO in the Hardware configuration interface, select Insert
PROFINET IO System from the context menu, and open the "Properties -
Ethernet interface PN-IO" dialog box, as shown in the figure below.
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b. Click the Parameters tab, click New, then click OK to create the PROFINET
subnet.
Upon successful creation of the PROFINET subnet, the display appears as shown
in the figure below.

c. Double-click the GL20 series module in the right device list, or drag the GL20
series module to the "Ethernet (1): PROFINET IO system (100)" subnet to
complete the configuration of the GL20-RTU-PN module.

5. Modify the IP address and device name of the GL20-RTU-PN module, and assign the
device name to the GL20-RTU-PN module.

a. Double-click the configured GL20-RTU-PN module, modify the device name and
IP address, then click OK, as shown in the figure below.
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b. In the "Hardware" configuration interface, navigate to the menu bar and select
PLC > EtherNet > Assign Device Name. In the opened window, click Update,
then select the device from the available device list and click Assign name to
assign the device name, as shown in the figure below.

6. Configure the expansion module.
In the "Hardware" configuration interface, click on the GL20-RTU-PN module, then
sequentially double-click the expansion modules in the right device list according
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to the actual installation sequence to add them and automatically assign
addresses, as shown in the figure below.

Note
If this product interfaces with the S7-300 series master and the CP343-1 Ethernet
communication module, and only Inovance expansion modules are used, it is
recommended to modify the I or Q address of the first module to start from "0" to
facilitate parameter configuration when using the PNIO_SEND(FC11) and PNIO_RECV
(FC12) program blocks later. Otherwise, attention must be paid to the relevant
parameter configurations. For details, see "4.5 Notes" on page 66.

7. Download the configuration settings and perform online monitoring to verify the
correctness of the configuration.

a. Click on the toolbar, select the corresponding PLC device in the opened
dialog box, and click OK to download the configuration settings to the PLC, as
shown in the figure below.
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b. Click to access the online monitoring configuration, as shown in the figure
below.
If the configuration shows no errors, it indicates that the GL20-RTU-PN module
configuration is successful; otherwise, the configuration has failed. If the
configuration fails, contact Inovance for technical support.
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4.4 Applicable for SIMOTION SCOUT
Prerequisite

● The relationship between the firmware version compatibility of the GL20-RTU-PN
module, the expansion modules, their firmware versions, functionalities, and GSD
file versions has been understood. For details, see "1.6 Release Notes" on page 21.

Note
To check the firmware version and related module versions of the GL20-RTU-PN
module, See "6.2 Share IN and Share OUT Mapping Modules" on page 76.

● The GSD file is ready. You can get the GSD file from https://www.inovance.com.

Operating procedure

1. Complete the cable connections, then power on and initiate the operation of this
product.

2. Create a new project, taking the SIMOTION D425-2 DP/PN as an example, as shown
in the figure below.

3. Import the GSD file.

https://www.inovance.com/portal/product/details?productId=343.
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a. In the navigation tree of SIMOTION SCOUT on the left, right-click D425 [D425-2
DP/PN], and select Open HW configuration from the context menu, or double-
click D425 [D425-2 DP/PN] to enter the hardware configuration interface, as
shown in the figure below.

b. In the hardware configuration interface, select Options > Install GSD Files from
the menu bar to open the "Install GSD Files" dialog box, as shown in the figure
below.

c. Click Browse... to select the path where the GSD file is located, then click OK.
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d. Click Install to start the installation. Once the installation is complete, the GL20
series module can be found in the device list on the right, as shown in the figure
below.

4. Configure the GL20-RTU-PN module.

a. In the hardware configuration interface, drag the "SIMOTION D425-2"
configuration window and the "Ethernet(1): PROFINET IO system (100)" line
segment to appropriate positions to reserve space for configuring the GL20-
RTU-PN module, as shown in the figure below.
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b. Double-click the GL20 series module in the right device list, or drag the GL20
series module to the "Ethernet (1): PROFINET IO system (100)" subnet to
complete the configuration of the GL20-RTU-PN module.

5. Modify the IP address and device name of the GL20-RTU-PN module, and assign the
device name to the GL20-RTU-PN module.

a. Double-click the configured GL20-RTU-PN module, modify the device name and
IP address, then click OK, as shown in the figure below.
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b. In the "Hardware" configuration interface, navigate to the menu bar and select
PLC > EtherNet > Assign Device Name. In the opened window, click Update,
then select the device from the available device list and click Assign name to
assign the device name, as shown in the figure below.

6. Configure the expansion module.
In the "Hardware" configuration interface, click on the GL20-RTU-PN module, then
sequentially double-click the expansion modules in the right device list according
to the actual installation sequence to add them and automatically assign
addresses, as shown in the figure below.
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7. Download the configuration settings and perform online monitoring to verify the
correctness of the configuration.

a. Click on the toolbar, select the corresponding PLC device in the opened
dialog box, and click OK to download the configuration settings to the PLC, as
shown in the figure below.
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b. Click to access the online monitoring configuration, as shown in the figure
below.
If the configuration shows no errors, it indicates that the GL20-RTU-PN module
configuration is successful; otherwise, the configuration has failed. If the
configuration fails, contact Inovance for technical support.
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4.5 Notes
● When this product interfaces with the S7-300 series master and the CP343-1

Ethernet communication module, the PNIO_SEND(FC11) and PNIO_RECV(FC12)
program blocks are required, as shown in the figure below. The parameter
configuration instructions are detailed in the following table.



‑67‑



‑68‑

Parame-
ter

Variables
Declara-

tion

Data
Type

Description

LEN INPUT INT Indicates the length of the data area to be sent or
received, which is measured in bytes, and always
calculated starting from address 0 of the data area.

● When the I or Q address of the first expansion module
applicable to this product starts from 0, this parameter
should be set according to the actual length of the last
expansion module. For example, if the I address ranges
from 0 to 9, then LEN should be set to 10. The same
applies to the Q address.

● When the I or Q address of the first expansion module
applicable to this product does not start from 0, this
parameter should be set according to the length
calculated from the last expansion module's I or Q
address starting at 0. For example, if the I address
ranges from 68 to 83, then LEN should be set to 84. The
same applies to the Q address.

SEND IN_OUT ANY Indicates the data sending area, which is a peer data area
with the expansion module, and used for data exchange
between the S7-300 series master and the expansion
modules.
The format is: P#Mx.0 BYTE y, where x represents the
starting address of the S7-300 series master data area,
and y represents the length of the S7-300 series master
data area, with the value of y being equal to the LEN
value.

RECV IN_OUT ANY Indicates the data receiving area, which is a peer data
area with the expansion module, and used for data
exchange between the S7-300 series master and the
expansion modules.
The format is: P#Mx.0 BYTE y, where x represents the
starting address of the S7-300 series master data area,
and y represents the length of the S7-300 series master
data area, with the value of y being equal to the LEN
value.
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● For GSD file versions updated after 20240401, if encountering the issue shown in
the figure below, it is necessary to delete the 1600END module from the
corresponding configuration settings, update the GSD file, and then re-add the
1600END module.
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5 Fault Diagnosis
LED Indicator

Status
Description Cause Solution

ERR Solid on
(red)

Protocol stack failed
to scan for modules

The expansion
module does
not exist.

Check that the module is
installed properly and supplied
with power.

No expansion
module was
scanned due to
local bus
communication
failure.

Check the contact of the
communication interface of
the expansion module or
restart the whole system

Flashing
(red)

● Number of
configured I/O
modules greater
than the number of
actual scanned I/O
modules

● Number of
configured I/O
modules less than
the number of actual
scanned I/O modules

● Type of configured I/
O modules
inconsistent with
that of actual
scanned I/O modules

The actual slot
of the
expansion
module is
inconsistent
with the
configuration.

Check the number and
installation sequence of
expansion modules.

The local bus
communication
failure causes
that the
module
scanned is
inconsistent
with the
configuration.

Check the contact of the
communication interface of
the expansion module or
restart the whole system

Share IN/Share OUT
module position or
number error

The Share IN or
Share OUT
module should
be placed at
the end of the
module list.
Only one Share
IN module and
one Share OUT
module are
allowed.

Check the slot or number of
Share IN or Share OUT
modules.
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LED Indicator
Status

Description Cause Solution

SF Solid on
(red)

● I/O module
configuration failed

● I/O module status
switch failed

The local bus
communication
failure causes
an error when
the master
module
interacts with
the expansion
module.

Check the contact of the
communication interface of
the expansion module or
restart the whole system

I/O module offline The I/O module
was powered
off or removed.

Check whether the module in
the corresponding slot is
powered off or removed.

The error
occurs due to
high frame loss
rate of local
bus
communica-
tion.

Check the contact of the
communication interface of
the expansion module or
restart the whole system

SF
Flashing
(red)

Power supply
overvoltage

Unstable
module power
supply or
power failure

Check the power supply of the
module.

Power supply
undervoltage

External 24 V power
supply failure
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LED Indicator
Status

Description Cause Solution

SF
Flashing
(red)

Chip overtemperature The DAC device
temperature is
too high.

1. Check whether the
module hardware is
faulty.

2. Replace the module.ADC device fault The ADC device
is faulty.

DAC device fault The DAC device
is faulty.

Reference channel
fault

The TC module
cold end
sampling
channel is
faulty.

1. Check the TC module cold
end channel hardware.

2. Replace the module.

Channel x open-
circuited

The analog
channel wiring
is
disconnected.

1. Check the external wiring
of the module channel.

2. If the external wiring is
correct, it is
recommended to check
the internal hardware of
the module or replace the
module.

Channel x short-
circuited

The analog
channel wiring
is short-
circuited.

Channel x data
exceeds upper limit

The channel
data is
abnormal and
out of normal
range.

Check whether the external
input signal of module is
abnormal.Channel x data

exceeds lower limit

Channel x data
overflow

Channel x data
underflow
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6 Appendix

6.1 Configuring the MRP

■ MRP overview
The standard Media Redundancy Protocol (MRP) is used, which meets the IEC 62439-2
standard. The typical reconstruction time is 200 ms and each ring network supports
up to 50 devices.

MRP basic rules:
● All nodes on the ring network must support the MRP and have the MRP enabled.

● All devices must be interconnected through ports on the ring network.

● All devices in the ring network are in the same redundancy domain.

● A maximum of 50 devices can be connected in a ring network. More devices will
prolong the reconstruction time of 200 ms.

● Only one device in the ring network can serve as the ring network manager, and
other devices are all ring network clients.

The MRP topology diagram is shown in the figure below.

■ MRP setting
1. Select the PLC port, navigate to Properties > Media redundancy, set the "Media

redundancy role" to "Admin", and check the parameters of "Ring port 1" and "Ring
port 2".
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2. Select an I/O device port, navigate to Properties > Media redundancy, set the
"Media redundancy role" to "Client", and check the parameters of "Ring port 1"
and "Ring port 2".
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3. Select an I/O device port, navigate to Properties > IO cycle, and adjust the
"Update time" to an appropriate value so that the "Watchdog time" is greater than
200 ms.

Note
MRP provides a typical reconstruction time of 200 ms and supports up to 50 devices
in each ring network. To avoid interference to PROFINET communication during ring
network reconstruction, set the PROFINET watchdog time of the I/O device to be
greater than 200 ms.
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6.2 Share IN and Share OUT Mapping Modules

The Share IN and Share OUT are mapping modules, and must be added at the end of
all modules; otherwise, the modules will fail to operate.

■ Byte description
The first two bytes of Share IN will be refreshed in real time, respectively

corresponding to the local bus status and PROFINET communication status. The
values under normal status, 0x08 (local bus) and 0x02 (PROFINET communication)
can be used for program judgment.
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Address Description Value

First byte of Share IN Local bus status ● 0x01: init
● 0x02: preop
● 0x04: safeop
● 0x08: op
● 0x10: safeop2op
● 0x20: op2safeop
● 0x80: error

Second byte of Share IN PROFINET communication
status

● 0x01: disconnected
● 0x02: connected

Share IN will be displayed according to the value of Share OUT from the 4th byte.
This function can only be used when both Share IN and Share OUT modules exist, and
corresponding values need to be entered in Share OUT.

Share OUT input value Share IN feedback value
meaning

Length

0x01 App version 4 consecutive bytes

0x02 FPGA version 4 consecutive bytes

0x03 PN version 4 consecutive bytes

0x04 GSD version 4 consecutive bytes

0x10 Slot 1 module version
information

8 consecutive bytes

0x11 Slot 2 module version
information

8 consecutive bytes

0x12 Slot 3 module version
information

8 consecutive bytes

0x13 Slot 4 module version
information

8 consecutive bytes

0x14 Slot 5 module version
information

8 consecutive bytes

0x15 Slot 6 module version
information

8 consecutive bytes

0x16 Slot 7 module version
information

8 consecutive bytes
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Share OUT input value Share IN feedback value
meaning

Length

0x17 Slot 8 module version
information

8 consecutive bytes

0x18 Slot 9 module version
information

8 consecutive bytes

0x19 Slot 10 module version
information

8 consecutive bytes

0x1A Slot 11 module version
information

8 consecutive bytes

0x1B Slot 12 module version
information

8 consecutive bytes

0x1C Slot 13 module version
information

8 consecutive bytes

0x1D Slot 14 module version
information

8 consecutive bytes

0x1E Slot 15 module version
information

8 consecutive bytes

0x1F Slot 16 module version
information

8 consecutive bytes

0x20 Slot 17 module version
information

8 consecutive bytes

0x21 Slot 18 module version
information

8 consecutive bytes

0x22 Slot 19 module version
information

8 consecutive bytes

0x23 Slot 20 module version
information

8 consecutive bytes

0x24 Slot 21 module version
information

8 consecutive bytes

0x25 Slot 22 module version
information

8 consecutive bytes

0x26 Slot 23 module version
information

8 consecutive bytes

0x27 Slot 24 module version
information

8 consecutive bytes
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Share OUT input value Share IN feedback value
meaning

Length

0x28 Slot 25 module version
information

8 consecutive bytes

0x29 Slot 26 module version
information

8 consecutive bytes

0x2A Slot 27 module version
information

8 consecutive bytes

0x2B Slot 28 module version
information

8 consecutive bytes

0x2C Slot 29 module version
information

8 consecutive bytes

0x2D Slot 30 module version
information

8 consecutive bytes

0x2E Slot 31 module version
information

8 consecutive bytes

0x2F Slot 32 module version
information

8 consecutive bytes

■ Operation example
1. In the hardware directory tree, double-click Share IN and Share OUT respectively

to add them to the end of the module, as shown in the figure below.

2. Monitor the addresses "%IB84" and "%IB85" on the monitoring table to check the
local bus status and PROFINET communication status.
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● "16#08" indicates normal local bus operation.
● "16#02" indicates normal PROFINET communication operation.

3. View the APP version information.
Assign "0x01" to the first byte of the Share OUT mapping module. The Share IN
module obtains the feedback values as shown in the following figure, indicating
that the APP version is "1.0.1.7".

4. View the module version information.
Assign "0x14" to the first byte of the Share OUT mapping module. The Share IN
module obtains the feedback values as shown in the following figure, indicating
that the logic version of the fifth module is "0.1.2.0" and the CPU version is
"1.1.0.0".
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Note
The modules supporting CPU version number queries are: GL20-4AD, GL20-4AD-DF,
GL20-4DA, GL20-4PT, GL20-4TC, GL20-3232ETN, GL20-0032ETN, GL20-3200END, and
GL20-3200END-M.

6.3 Expansion Module Parameter Description

■ GL20-4AD/GL20-4AD-DF/GL20-8ADI/GL20-8ADV expansion module
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- Input Rated
Range

Rated Range Input Limit
Range

Limit Range GSD Interface
Range

Analog
voltage input

-10 V to +10 V -20,000 to
+20,000
-32,000 to
+32,000
-27,648 to
+27,648

-10.20 V to
+10.20 V

-20,400 to
+20,400
-32,640 to
+32,640
-28,200 to
+28,200

-20,000 to
+20,000
-32,000 to
+32,000
-27,648 to
+27,648

0 V to 10 V 0 to 20,000
0 to 32,000
0 to 27,648

-0.5 V to
+10.24 V

-1,000 to
+20,400
-1,600 to
+32,640
-1,382 to
+28,200

-20,000 to
+20,000
-32,000 to
+32,000
-27,648 to
+27,648

-5 V to +5 V -20,000 to
+20,000
-32,000 to
+32,000
-27,648 to
+27,648

-5.10 V to
+5.10 V

-20,400 to
+20,400
-32,640 to
+32,640
-28,200 to
+28,200

-20,000 to
+20,000
-32,000 to
+32,000
-27,648 to
+27,648

0 V to 5 V 0 to 20,000
0 to 32,000
0 to 27,648

-0.25 V to
+5.10 V

-1,000 to
+20,400
-1,600 to
+32,640
-1,382 to
+28,200

-20,000 to
+20,000
-32,000 to
+32,000
-27,648 to
+27,648

1 V to 5 V 0 to 20,000
0 to 32,000
0 to 27,648

0.8 V to 5.10
V

-1,000 to
+20,400
-1,600 to
+32,640
-1,382 to
+28,200

-20,000 to
+20,000
-32,000 to
+32,000
-27,648 to
+27,648
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- Input Rated
Range

Rated Range Input Limit
Range

Limit Range GSD Interface
Range

Analog
current
output

-20 mA to +20
mA

-20,000 to
+20,000
-32,000 to
+32,000
-27,648 to
+27,648

-20.50 mA to
+20.50 mA

-20,400 to
+20,400
-32,640 to
+32,640
-28,200 to
+28,200

-20,000 to
+20,000
-32,000 to
+32,000
-27,648 to
+27,648

0 mA to 20
mA

0 to 20,000
0 to 32,000
0 to 27,648

-1 mA to
+20.50 mA

-1,000 to
+20,400
-1,600 to
+32,640
-1,382 to
+28,200

-20,000 to
+20,000
-32,000 to
+32,000
-27,648 to
+27,648

4 mA to 20
mA

0 to 20,000
0 to 32,000
0 to 27,648

3.2 mA to
20.50 mA

-1,000 to
+20,400
-1,600 to
+32,640
-1,382 to
+28,200

-20,000 to
+20,000
-32,000 to
+32,000
-27,648 to
+27,648

Note
Due to GSD file restrictions, although the interface currently only displays three
ranges (-20,000 to +20,000, -32,000 to +32,000, and -27,648 to +27,648), it actually
supports the other ranges listed in the table above. For example, if a range of 0 V to 10
V is selected, the corresponding ranges would be 0 to 20,000, 0 to 32,000, or 0 to
27,648. Since the -20,000 to +20,000 range includes the 0 to 20,000 range, you can
directly select -20,000 to +20,000 option on the interface. The same logic applies to
other ranges.

The parameters within the red box in the interface are described in the following
table.
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Parameter Description

PeakHoldEn Keep the maximum collected value if subsequent values do not exceed the
current value. Check to enable.

OpenChkEn Trigger the alarm when no wiring input is detected, supporting the ranges
of 1 V to 5 V and 4 mA to 20 mA. Check to enable.

OverRan-
geChkEn

Trigger the alarm when the exceeding the rated range is detected. Check to
enable (excluding 0 V to 10V, 0 V to 5V, 1 V to 5 V, 0 mA to 20 mA, and 4 mA
to 20 mA; values below -200 are considered below the lower limit, while
those above 20,000 are considered above the upper limit).

OverFlowEn Trigger the alarm when exceeding the limit range is detected. Check to
enable.

If 4 mA to 20 mA and 0 to 27648 mode are selected, the sampled value will be
displayed without wiring:

● If the parameter within the red box is not checked, it displays -1382
(corresponding to -1000 out of ±20000).

● If the "OpenChkEn" option is checked, it displays -1382 (corresponding to -1000
out of ±20000).

● If the "OverFlowEn" option is checked, it displays -1382 (corresponding to -1000
out of ±20000).

■ GL20-4PT/GL20-4TC expansion module
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Parameter Description

Temperature
Unit

Celsius and Fahrenheit are optional. Choose based on actual conditions.

Bias Set the temperature offset value. This parameter takes effect when "Detect
Drift" is configured as "Enabled". Set the offset value as needed.

UpLimit Set the upper temperature limit. Set this parameter based on the range
values of the corresponding temperature unit, with precision to one
decimal place.

DownLimit Set the lower temperature limit. Set this parameter based on the range
values of the corresponding temperature unit, with precision to one
decimal place.

Detect Drift Set whether to enable temperature offset detection. This parameter is used
in combination with the "Bias" parameter. This function takes effect when
set to "Enable".

For the technical specifications of GL20-4PT/GL20-4TC, see "Technical Specifications"
section in the corresponding User Guide.

■ GL20-0004ER/GL20-0008ER/GL20-0800END/GL20-0008ETN/GL20-
0008ETP/GL20-0808ETN/GL20-1600END/GL20-0016ETP/GL20-
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0016ETN/GL20-3232ETN-M/GL20-0032ETN-M/GL20-3200END-M/GL20-
0032ETN/GL20-3200END expansion module

Parameter Description

FailSafeMode Set the output mode upon stop/disconnection. "OutputHold" and
"OutputPreSetVal" are optional, with the following meanings:

● OutputHold: Keep present output status
● OutputPreSetVal: Output according to preset value, used in combination
with the "PreSetVal" parameter.

PreSetVal Set the preset value upon stop/disconnection. Set to "0" or "1" as needed.
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■ GL20-2SSI expansion module

Parameter Description

SSI Enable Check to enable the channel.
Drop-down options:

● Checked
● Unchecked
Default: Checked

SSI Multiple
Sampling
Mode

Turn the mode on to check the validity of the encoder position value. A
fault code will be sent to the host if the value is invalid.
Drop-down options:

● OFF
● ON
Default: OFF
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Parameter Description

SSI Baudrate The baud rate affects the accuracy of the encoder as well as the rate of
position updates. You can adjust it according to the actual transmission
rate and performance of the encoder. (Unit: bps)
This parameter is strongly related to the encoder performance.
Drop-down options: 100k/200k/300k/400k/500k/1000k/1250k/1500k/2000k
Default: 500k

SSI Coding Select the coding mode according to the encoder type.
Drop-down options:

● Gray Code
● Binary Code
Default: Gray Code

SSI Type
Change

● When SSI Type Change is set to "gray", configure this parameter if you
need to upload data as binary code.

● When SSI Type Change is set to "binary", use the default value.
Drop-down options:

● None
● Gray->Bin
Default: None

SSI Frame
Type

It is recommended to select "Variable" when there are status bits in the
encoder bits.
This parameter should be used in combination with "DataBit Size" and
"Frame Size".
Drop-down options:

● SingleTurn-13Bit
● MultiTurn-25Bit
● Variable
Default: MultiTurn-25Bit
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Parameter Description

SSI Parity
Check

If the assigned parity check is for a 25-bit encoder, 26 bits can be read from
the encoder. The bit after the least significant bit will be judged as the
parity bit, and parity errors will be sent to the host in the form of a fault
code.
Drop-down options:

● None
● Odd check
● Even check
Default: None

SSI Direction
invert

The inversion function can adjust the motion direction of the absolute
encoder to the direction of the motion axis.
Drop-down options:

● No invert sign
● Invert sign
Default: No invert sign

SSI
transmission
interval

Set the interval according to the encoder specifications. If you need to
increase the response speed of the encoder, you can adjust this parameter
according to the performance of the encoder.
This parameter is strongly related to the encoder performance.
Drop-down options: 16/32/48/64/512/1024
Default: 1024

SSI Frame
Size

When switching frame types, manually adjust this value according to the
actual bit length of the frame type.
Value range: 0 to 32.
Default: 25

SSI MSB
config

When switching frame types, manually adjust this value according to the
actual bit length of the frame type.
Value range: 0 to 32.
Default: 25

6.4 DeviceStates Command
DeviceStates: Read module state information of the I/O system.
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■ Graphic block

See the following table for the command pins and their definitions.

Pa-
rame-
ter

Declara-
tion Type

Data Type Storage Area Description

LADDR Input HW_
IOSYSTEM

I, Q, M, L, or
constants

PROFINET I/O hardware identifier

MODE Input UINT I, Q, M, D, L, or
constants

1: I/O device/DP slave configured
2: I/O device/DP slave fault
3: I/O device/DP slave disabled
4: I/O device/DP slave present
5: faulty I/O device/DP slave
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Pa-
rame-
ter

Declara-
tion Type

Data Type Storage Area Description

STATE InOut VARIANT I, Q, M, D, L I/O device state buffer

RET_
VAL

Return INT I, Q, M, D, L Error code [1] format: W#16#...
0: No error
8091: The hardware identifier for the
LADDR parameter does not exist.
Check if the LADDR value is present in
the project (e.g., within the system
constants).
8092: LADDR does not address
PROFINET I/O or DP master systems.
8093: The data type in the STATE
parameter is invalid.
80B1: The CPU does not support the
DeviceStates command.
80B2: The CPU in the I/O system
specified by the LADDR parameter
does not support the selected MODE
parameter.
8452: Complete state information,
not applicable to variables configured
in the STATE parameter. [2]

Note
● [1]: In the program editor, error codes will be displayed as integers or

hexadecimal values.
● [2]: To check the field length of variables configured in STATE, the

CountOfElements instruction can be invoked. When the data type VARIANT
points to an Array of BOOL, this instruction counts the number of padding
elements; for example, when using Array [0...120] of BOOL, the field length is
128. Therefore, when the sum of the set field elements and the padding
elements created by the CPU is less than the value 1024 or 128, the
DeviceStates will only return the error code W#16#8452.
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■ Command description
The STATE parameter indicates the states of the I/O device/DP slave selected by the
MODE parameter.

If the state selected by MODE is applicable to the I/O device/DP slave, set the
following bits to "1" in the STATE parameter:
● Bit 0 = 1: Group display, where at least one I/O device/DP slave has the nth bit set

to "1".

● Bit n = 1: The state selected by MODE will be applied to the I/O device/DP slave.
■ For the PROFINET I/O system, the nth bit corresponds to the device number of

the I/O device (refer to the DP slave properties in the device view and network
view).

■ For the PROFINET DP system, the nth bit corresponds to the PROFIBUS address
of the DP slave (refer to the DP slave properties in the device view and network
view).

Use "BOOL" or "Array of BOOL" as the data type:

● To display only state information for group bits, use the BOOL data type in the
STATE parameter.

● To output the state information of all I/O devices/DP slaves, use an Array of BOOL
with the following length:
■ For PROFINET I/O system: 1,024 bits
■ For DP master system: 128 bits

■ Command examples
1. Add one GL20-RTU-PN and the expansion modules.

2. Invoke diagnostic command.
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3. Configure command-related parameters.
Parameter Description

LADDR Double-click the input assistant, then select
the module added by default in the system.

MODE Assign a value of 2, where 2 indicates a slave
fault.

STATE Create a BOOL array to store the data.

Ret_VAL Used for viewing command error codes.

4. Download the program and check the I/O system states and fault buffer. All states
are normal if all entries in the fault buffer display "FALSE".
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5. Disconnect the I/O system communication line. The interface displays the fault
icon, and the first two BOOLs in the fault buffer are set to "TRUE".

● Bit 0=1: At least one I/O device has failed.

● Bit 1=0: I/O device with device number 1 is not faulty.
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6.5 Firmware 2.0.0.5 and GSD 20230323 Compatibility
Module/Function Description

GL20-0008ER/GL20-0800END/GL20-
0008ETN/GL20-0008ETP/GL20-0808ETN/
GL20-3232ETN-M/GL20-0032ETN-M/GL20-
3200END-M/GL20-4PT/GL20-4TC

● For GL20-0008ER/GL20-0800END/GL20-
0008ETN/GL20-0008ETP/GL20-0032ETN-M/
GL20-3200END-M: function properly.

● For GL20-0808ETN/GL20-3232ETN-M/GL20-
4PT/GL20-4TC: Unable to function
properly, displaying abnormal error
messages.

Digital range of GL20-4AD/GL20-4DA The GL20-4AD/GL20-4DA expansion module
uses the new range "27648". When a 10 V
voltage is applied to channel 0, if effective,
the acquired value should be "27648".
Otherwise, the acquired value will be 19999
(20000) as the default range is "20000".

Set overflow flag GL20-1600END/GL20-0016ETP/GL20-
0016ETN/GL20-4AD/GL20-4DA expansion
modules use overflow detection enable. The
overflow will still be alerted even when the
overflow flag is unchecked, as legacy
versions of the modules have always
included overflow alert function.

Individual bitwise settings Function properly.

MRP Unable to function properly, displaying
abnormal error messages.
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